
 MANUAL FOR GRANDMAN WINDOWS 

(First revision  10-17-07, no figures yet) 

[please watch us develop this manual, patience please] 

WHAT THE PROGRAM CAN DO FOR YOU 

GrandMan Search for Windows consists of a program and a data file. The data file is the text of the three 

Revelations (the Old Testament, the New Testament, and the Writings of the Second Coming). You can see 

these in Appendix 1 and 2. This text is well over 40 million characters. But then you need to have some way of 

reading it, and that is where the program comes in. 

The program reads the text data and puts it on your computer screen. Part of this program is commercial 

software, produced by the Folio Corporation, called Folio VIEWS. The other part is software written by Walter 

J. Weiss, and the necessary text changes were effected by Jan H. Weiss. 

The program makes it possible for the user to search anywhere in the data file, also to go from one portion of 

the Bible to other portions in the Writings and from portions in the Writings back to the passages in the Bible. 

There are over 100,000 such links to do this. The GrandMan Program, pretty well replaces the famous Searle’s 

Index and the Potts Concordance. 

Folio VIEWS is a very powerful program. As you will soon discover for yourself; it allows you to navigate and 

search large amounts of text with ease. If you are reading a passage in the Bible, you can click on the verse, and 

immediately you will see all the passages in the Writings who explain this verse. When the Writings make a 

reference to a verse in the Old Testament, then a click of the mouse will bring up that verse for you to read, 

after which you can go back to where you were in the Writings.  

You can search all three Revelations for the occurrence of any combination of words and phrases, and you can 

do the same search restricted to just selected books or chapters. If you type in the query window in quotation 

marks the words Lead us not into tempation, you will find the two passages in the New Testament, and the five 

passages in the Writings. All this is done quickly and easily by the GrandMan Program. 

You can read anywhere in these books anytime, and you can get to where you want to read in a number of 

ways. You can search for a word or a combination of words. You can find the beginning of a book, or of a 

chapter, or a verse, in the Bible, or you can find any number of any book of the Writings. 

The Shadow File enables you to do many things, like change the text, make many different studies, which you 

then you then can transfer to other users of GrandMan. For more particulars so the section of Shadow Files. 

 

HOW IT COMES TO YOU 

The program comes to you on a CD disk and you will have to transfer it from this CD to your hard disk. Once 

you have done that, you can store the CD disk until you may have to do again for some reason. 

 

INSTALLING THE PROGRAM 

Before using the GrandMan Search program, you must FIRST install all the program and text files onto the hard 

disk of your computer. To do this, proceed as follows. 

1.  Put the GrandMan disk in your CD-ROM drive. 



2.  Click on the Start button. 

3.  Click on the Run menu item. 

4.  Click on the Browse button. 

5.  In the File Name: text box, enter “C:\” and click the Open button. 

6.  In the File Name: text box enter “..”, which will replace “C:\”; and click the Open button. 

7.  Double click on the drive icon to the left of "GRANDMANWIN".  

8.  Click on SETUP.EXE file icon.(.EXE may not be displayed) 

9.  Click on the Open button. 

10.  Click on the OK button. 

11.  Click on Continue button. 

12.  Click on the "Copy to and run from local drive" radio button. 

13.  Click on the Continue button. 

14.  Click on the Continue button. 

15.  Close the "GrandMan Windows" explorer window. 

16.  Click on the OK button. 

17.  Click on the Start button. 

18.  Click on the Run menu item. 

19.  Click on the Browse button. 

20.  Click on RUNONHD.BAT file icon.(.BAT may not be displayed) 

21.  Click on the Open button. 

22.  Click on the OK button. You will have to wait 15 to 60 seconds for a DOS window to start and complete 

the necessary copying. You are done. 

 

STARTING THE PROGRAM 

To start the GrandMan Search proceed as follows: 

1. Click on START. 

2. Then go to either All Programs, then to GrandMan Windows, then to Infobase.GrandMan, and click there. 

3. Now the green title page will appear for about 10 seconds, and then you are in the program. 

BEFORE HANDLING THE PROGRAM 

When you see an asterisk ( * ), there may not be instruction for that item. Either look in the Folio Manual, or 

write nco@secondadevnt.net 

 

HOW TO WORK WITH THE MANUAL 



We have worked hard on this manual, and our advice is that you keep the GrandMan Program on your monitor, 

and read through the whole manual. You may not remember it all, but that is allright, for then you will know 

what your manual says and where it says this, so you can go back there later on again and again when it is 

needed. 

 

USING THE MOUSE IN GRANDMAN 

To point to an item on the screen means to place the tip of the mouse pointer on the item. To click an item on 

the screen means to point to that item, and then press and release the left button of the mouse. To double click 

an item means to press that button twice. To right-click an item means to to point at that item, and then press 

and release the right button of the mouse. 

Look carefully at the document window. You will see a blinking vertical line. This is the cursor, which always 

shows your position in the text. It behaves the same way as the cursor in a word processing  

THE OPENING SCREEN 

When the program has been loaded on the hard disk, you will first see the Opening Screen with the Title Page. 

After a few seconds this Title Page will disappear, and you are looking at the Main Screen. 

THE MAIN SCREEN 

In the top of screen you will find the Title Bar, and below that the Menu Bar, and below that the Reference 

Window, and below that the Document Window. On the left you will find the Toolbelt, on the right Vertical 

Scroll Bar, and in the very bottom the Status Bar. 

EXPLAIN  TITLE BAR 

The Title Bar displays the name of the program. 

EXPLAIN REFERENCE WINDOW 

In the Reference Window you will find where in the total text you are at any moment. Push CTRL Home, and 

you will see that window change. Push CTRL End, and it will show the end of the text. 

EXPLAIN  DOCUMENT WINDOW 

In the Document Window you will see the text of the three revelations, whatever you call there. 

EXPLAIN  MENU BAR ITEMS 

The menu bar provides access to all the features of GrandMan Search. It has the words File, Edit, View, Search, 

Layout, Customize,Window, and Help, If you click on any word, another list of words and features drops down. 

You can do the same thing by pressimtg the ALT key and the underlined letter. For example, ALT+F will bring 

down the file menu. 

Hint: Next to some of the items in the drop-down menus you will see a “shortcut” keystroke. For example, the 

first item on the View menu is Table of Contents CtrI+T. This means that pressing CTRL+T will have the same 

effect as selecting the View menu and then selecting the Table of Contents item. If you make a small effort to 

learn the “shortcut” keys for operations which you perform often, you will find that the program is noticeably 

easier to use. 

FILE 



File has New, Open CTRL O, Close CTRL F4, Save CTRL S, Save as, Page Setup, Print, Print Setup, Login, 

Security, Information, Preferences, Exit Alt F4. 

NEW 

OPEN 

CLOSE 

SAVE 

SAVE AS 

PAGE SETUP 

PRINT 

PRINT SETUP 

LOGIN 

SECURITY 

INFORNATION 

PREFERENCES 

EXIT 

EDIT 

Edit has Undo, Cut, Copy, Paste. Paste Special, Object, Object Manager, Spelling, Replace, Tag Record F6, 

Invert Tags, Keep Tags, Clear all Tags.  

UNDO* 

CUT* 

COPY* 

PASTE 

PASTE SPECIAL 

OBJECT* 

OBJECT MANAGER 

SPELLING 

REPLACE 

TAG RECORD 

INVERT TAGS 

KEEP TAGS* 

CLEAR ALL TAGS* 

VIEW 

View has Table of Contents CTRL T, Reference Window, Hidden, Codes, Records with Hits, Rule, Ribbon. 



TABLE OF CONENTS 

Using the Table of Contents 

Let us say that you want to read chapter 6 of the Book of Joshua. It would be possible to find this passage using 

only the cursor keys and scroll bar, but it would be cumbersome. A better way would be to use the table of 

contents. Click the Contents tool. (Alternately, press CThi.+T, or choose View, Table of Contents.) Note that 

the Reference Window and the Document Window have been replaced by the Contents Window, where you can 

see the three top-level headings: Old Testament, New Testament, and Writings of Emanuel Swedenborg. 

To the left of each heading there is a plus sign. If the plus signs are not visible, choose Show Expandable 

Branches from the View menu. Double-click the plus sign next to Old Testament. (Alternately, press + on the 

keyboard). The Old Testament branch of the table of contents will be expanded, that is, the plus sign will 

change to a minus sign, and all the book-level headmgs — the titles of the books of the Old Testament-- will 

appear indented beneath the Old Testament heading. There is a plus sign next to the title of each book, 

indicating that it can be further expanded. Double-click the plus sign next to Book of JOSHUA. This branch 

will expand to show the chapters of the Book of Joshua In this book, there are no subheadings below the chapter 

level. This is indicated by the fact that there are no plus signs next to the chapter headings. (See Figure 6.) 

Figure 6. Table of Contents Window 

Click JOSHUA Chapter 6 so that it is highlighted by a blue bar. To return to the Document Window, click the 

Contents tool. (Alternately, press CTRL+T, or press ENTER, or choose View, Document). Note that the cursor 

is now at the beginning of the sixth chapter of Joshua. (See Figure 7.) 

Return to the Contents Window. Collapse the Old Testament branch by double-clicking the minus sign. Double-

click the plus sign in front of Writings of Emanuel Swedenborg to expand that branch. You will see the names 

of the 27 books of the Writings which are contained in the GrandMan Infobase. Expand the Arcana Coelestia 

branch to show the chapter headings. Note that most of the chapter headings have plus signs next to them. This 

is because there is a fourth level of subheadings, below the chapter leveL This level, called the “passage” level, 

is encountered only in the Writings, not in the Old Testament or the New Testament. Expand the branches under 

some of the Arcana chapters to see examples of “passage” headings. 

As you have seen, we can expand or collapse individual branches in the table of contents by clicking on 

appropnate plus signs or minus signs. But what if we want to expand or collapse all branches? This is easy to 

do. Press the 1 key in the top row of the main keyboard (not in the numenc keypad). All branches are collapsed 

to the first (“revelation”) level. Similarly, press 2 to expand all branches to the secomd (“book”) level, press 3 

for the third (“chapter’) level, and press 4 for the fourth (“passage) level. (Alternately, choose Search, Levels 

and double-click the name of the appropriate level.) Figure 7. Come Here from Figure 6 

Before you go on to the next topic, spend some time familiarizing yourself with the use of the Contents 

Window. Try looking up several different passages in each of the three revelations. 

Here is a tip  which you may find useful when using the table of contents. In order to return to the Document 

Window from the Contents Window without moving the cursor from where you left it in the Document 

Window, press CTRL-TAB. (Alternately, choose Grand Man Search Program from the Window menu). 

REFERENCE WINDOW 

The Reference Window 



You have already seen that the reference window is continually updated to display your position in the 

GrandMan Infobase with respect to the four levels of organization: revelation, book, chapter, and passage. 

There are only a few additional things to point out about the reference window. 

At any time that the reference window is visible, you can jump to the beginning of the current passage, the 

current chapter, the current book, or the current revelation, by double-clicking its name in the reference 

window. In the situation shown in Figure 7, for example, double-clicking Book of JOSHUA would take you to 

the beginning of that book. Try it. 

You can change the size of the reference window by choosing Preferences from the File menu and entering the 

number of lines to show. (See Figure 3.) You can also change the size of the reference window by using the 

mouse to drag the line which separates the reference window and the document window. 

HIDDEN 

CODES 

RECORDS WITH HITS 

RULER 

RIBBON  

SEARCH 

Search has Query F2, Next Hit F5, Previous Hit, F4, Go to CTRL G, Backtrack F5*, Show Trail, Query 

Template.  

QUERY 

NEXT HIT 

PREVIOUS HIT 

CLEAR QUERY 

GO TO 

BACKTRACK 

SHOW TRAIL 

QUERY TEMPLATE 

LAYOUT 

Layout has Character, Paragraph,Tabs, Border, Character Style, Paragraph Style, Level, Field, Remove Field, 

Object. 

CHARACTER 

 

PARAGRAPH 

 

TAB 

 

BORDER 

Overview 



Borders allow you to graphically enhance the appearance of your infobase quickly and easily. With the ability 

to set top, bottom, left, and right borders of varying styles, thicknesses, and colors, you can easily enclose notes, 

warnings, instructions, or other areas of interest in your infobase. 

Description 

The following procedures are detailed in this section: 

• Creating a Border 

• Removing a Border 

Creating a Border  

Borders affect entire paragraphs. To border a paragraph, the insertion point must be somewhere in the 

paragraph, or multiple paragraphs must be selected. 

Consider using a paragraph style or level style to create and apply borders. 

To create a border: 

Step 1 Access the border dialog. 

•The Border dialog may be accessed from the Layout menu or any one of several dialogs. 

 

Step 2 Enter the Line Width for each border you wish to include around the text. 

•Borders may be placed on the Top, Bottom, Left, or Right. 

•A width of zero (0) indicates no border. 

•Hairline borders have a measurement of 1 point or 0.013 inches. 

•You can use or modify one of the predefined borders. Click on one of the buttons on the right side of the dialog 

to select a border. The predefined borders are: 

–None: No borders on any side. A fill color may still be specified. (Keyboard users press ALT+N to select this 

option.) 

–All: Borders on all sides. (Keyboard users press ALT+A to select this option.) 

–Some: Borders on the top and bottom. (Keyboard users press ALT+S for this option.) 

Step 3 Enter the Distance from Text for each border. 

•Distance from Text measures the distance from the border to the text contained by the border. 

•Generally, Distance from Text should be less than ¼ inch. 

Step 4 Choose Line Color to specify the color of the border. 

•Line colors must be non-dithered colors. See Color for more information. 

Step 5 Choose Fill Color to specify the background color for the text enclosed by the border (if desired). 

•Fill colors must be non-dithered colors. See Color for more information. 

Step 6 Choose OK to close the Border dialog. 

•Choosing Cancel closes the Border dialog without saving or applying the changes. 

Removing a Border 

You may remove a border from text or objects by clearing all lines and setting the fill and line colors to white. 

If the border is created in a paragraph style or level style, you should remove it through the style. 

To remove a border: 

Step 1 Place the insertion point in the paragraph containing the border or select the object containing the 

border. 

Step 2  Acce ss the Border dialog. 

Step 3 Choose the None predefined border. 

•Click the top right button in the border dialog to choose None (or press ALT+N). 

•You may also manually type a zero into each of the Line Width and Distance from Text edit controls. 

Step 4 If the border has a fill color, choose Fill Color and set the color to white. (See Color for more 

information.) 



Step 5 Choose OK. 

•Choosing Cancel closes the dialog without making any changes to the border. 

Quick Keys 

None: ALT+N 

All: ALT+A 

Some: ALT+S 

CHARACTER STYLE 

PARAGRAPH STYLE 

LEVEL 

FIELD 

REMOVE FIELD* 

OBJECT* 

 

CUSTOMIZE 

 Customize has Bookmark CTRL M, Highlighter CTRL  H, Note, Remove Note, Jump Destination, Jump Link, 

Pop Up Link, Query Link, Object Link, Program Link, Remove Link, Group, Ungroup  

BOOKMARK 

Overview 

Bookmarks allow you to hold your place in an infobase while you browse, while you move to another infobase 

or application, or when you close the infobase. Use them to mark points of interest that you would like to return 

to quickly or to serve as guides through a research project. You may have an unlimited number of bookmarks, 

each individually named for easy reference, and may use them to mark any point in the infobase which you may 

need to return to later. 

Description 

The following procedures are detailed in this section: 

• Placing a Bookmark 

• Turning to a Bookmark 

Placing Bookmarks 

Place a bookmark at locations you want to return to quickly. 

To place a bookmark: 

Step 1 Place the insertion point where you want the bookmark to be located. 

Step 2 Choose Bookmark from the Customize menu. 

•Pressing CTRL+M also opens the Bookmark dialog. 

Step 3 Select Name and type a name for the bookmark. 

•Bookmarks must have unique names. 

•Use descriptive names for your bookmarks. 

•Bookmark names may be up to 127 characters long, including spaces. 

Step 4 Choose OK to place the bookmark. 

•Choosing Cancel closes the dialog without creating or placing a bookmark. 

Turning to a Bookmark 

Turn to a bookmark whenever you need to reference the information that it marks. 

To turn to a bookmark: 



Step 1 Choose Bookmark from the Customize menu. 

•Pressing CTRL+M also opens the Bookmark dialog. 

Step 2 Select the bookmark you wish to turn to. 

•Type the first one or two characters of the bookmark name, and then press the down arrow. The bookmark 

name should now be highlighted. 

Step 3 Choose OK to return to the bookmark location. 

•Choosing Cancel closes the dialog without turning to a bookmark. 

Quick Keys 

Bookmark: CTRL+M 

 

HIGHLIGHTER 

To highlight text or graphics with a highlighter: 

Step 1 Select the text you wish to highlight. 

Step 2 Choose Highlighter from the Customize menu. 

 •The Highlighter dialog appears. 

Step 3 Select the highlighter you wish to use.  

Step 4 Press ENTER or choose Apply to apply the highlighter to the selected text. 

•If you do not wish to apply the highlighter, press ESC or Close to quit. 

Clearing a Highlighter 

You may clear highlighters from selected text in the infobase. To clear a highlighter: 

Step 1 Select the text you wish to remove the highlighter from. 

Step 2 Choose Highlighter from the Customize menu. 

•The Highlighter dialog appears. 

Step 3 Select (None) from the Highlighter Name list. 

Step 4 Press ENTER or choose OK to clear all highlighters from the selected text. 

•If you do not wish to clear highlighters from the selected text, press ESC or Close to quit. 

Creating a New Highlighter 

Highlighters must be created before they can be applied. To create a highlighter: 

Step 1 Choose Highlighter from the Customize menu. 

•The Highlighter dialog appears. 

Step 2 Select Highlighter Name and type the name of the Highlighter you wish to create.  

•Highlighter names may be up to 123 characters in length (including spaces). 

Step 3 Choose Add.  

•The new highlighter is added to the Highlighter Name list. 

Editing a Highlighter 

You may add or remove character attributes from your highlighters. To edit an existing highlighter: 

Step 1 Choose Highlighter from the Customize menu.  

•The Highlighter dialog appears. 

Step 2 Select the highlighter you wish to edit from the Highlighter Name list.  

Step 3 Choose Character. 

•The Character dialog appears. 

Step 4 Select the options you wish to have added or removed from the highlighter. 

 •All of the options in the Character dialog may be applied. 

Step 5  Press ENTER or choose OK to modify the highlighter, ESC or Close to quit. 

Step 6 Press ENTER or choose Apply to apply the current highlighter to any selected text in the infobase and 

apply the changes of any other edited highlighters. 



•If you do not wish to apply the changes to any edited highlighters, press ESC or Close. 

Renaming Highlighters 

Highlighters may be renamed at any time. To rename a highlighter: 

Step 1 Choose Highlighter from the Customize menu.  

•The Highlighter dialog appears. 

Step 2 Select the highlighters you wish to rename from the Highlighter Name list.  

Step 3 Choose Rename.  

•The Rename dialog appears. 

Step 4 Enter the new name for the highlighter. 

Step 5 Press ENTER or choose OK to rename the highlighter. 

•If you do not wish to rename the highlighter, press ESC or Cancel to quit. 

Removing Highlighters 

Highlighters may be removed from the infobase. When a highlighter is removed, all occurrences of that 

highlighter are removed from the infobase and the highlighter name is deleted from the Highlighter Name list. 

There is no way to "undo" a remove, so be certain that you want to remove the highlighter before choosing this 

option. 

To remove a highlighter from the infobase: 

Step 1 Choose Highlighter from the Customize menu.  

•The Highlighter dialog appears. 

Step 2 Select the highlighter you wish to remove from the Highlighter Name list. 

Step 3 Choose Remove.  

•A dialog appears, verifying that you wish to remove the Highlighter.  

Step 4 Choose Yes to remove the style, No to quit. 

NOTE 

Use notes to annotate the infobase with your comments and suggestions. Notes appear as a note icon to the left 

of the paragraph where you create the note. (Each paragraph may have one note.) 

 

To create a note: 

Step 1 Place the insertion point (cursor) in the paragraph where you want the note. 

For practice, place the insertion point in the first record in the Online User's Guide. 

Step 2 Choose Note from the Customize menu. 

Step 3 Type the text you wish to appear in the note. 

For practice, type This is a great feature! 

•Click the right mouse button or press F10 to access the popup menu if you wish to format the text. 

Step 4 Press ESC to close the note. 

•Save the changes to the note when prompted. 

Step 5 Open the note at any time by double-clicking the note icon. Or place the insertion point in the record and 

choose Note from the Customize menu, or CTRL N 

 

REMOVE NOTE* 

When you no longer need the comments in a note, you may remove it. If you accidentally remove a note, 

choose Undo from the Edit menu before other edits are made to restore the note. 

To remove a note: 

Step 1 Place the insertion point in the paragraph containing the note you wish to remove. 

•You may remove notes from several paragraphs at the same time by first selecting all the paragraphs. 



Step 2 Choose Remove Note from the Customize menu. 

 

JUMP DESTINATION 

 Jump Destination CTRL D,  

AOUT LINKS 

This infobase uses all five of the standard VIEWS link types. Each link type, its appearance, and general use, 

are described below. 

To follow a link, double-click the link launch point. The link launch point is identified by colored, underlined 

text. You may also scroll to the link launch point and press CTRL+ENTER to follow the link. 

The types of links used in this infobase are: 

JUMP LINK* 

Jump Link CTRL J,  

POP UP LINK* 

QUERY LINK 

Query Link, 

OBJECT LINK* 

PROGRAM LINK* 

REMOVE LINK* 

GROUP 

UNGROUP 

. 

WINDOW 

Window has New Window, Cascade, Tile Vertical, Tile Horizontal, Arrange Icons, Close All, Refresh. 

NEW WINDOW 

CASCADE 

TILE VERTICALLY 

TILE HORIZONTALLY 

ARRANGE ICONS 

CLOSE ALL 

REFRESH 

HELP 

Help has Contents, Keyboard, Tutorial, Infobase, About. You investigate! 

CONTENTS 

KEYBOARD 

TUTORIAL 



INFOBASE 

ABOUT 

EXPLAIN TOOLBELT  ITEMS 

In the tool belt on the left you will see from top to bottom small square that you activate by a left cleck of the 

mouse. There is Open, Save, Query, Clear Query,Next, Previous, Back Track, Trail, Contents, Highlight, 

Bookmark, Go To, Field. 

These tools on the Toolbelt may be adjusted as needed to fit your individual usage. Choose these in the 

Preferences from the File menu.  

 

OPEN: 

Opens to four different info bases 

Step 1 Click the Open button on the Toolbelt.  

Step 2 Select the file you wish to open. 

Step 3 Choose OK. 

Clicking on icon opens to create sgadow file. 

 

SAVE 

 

QUERY:  

Opens the Query dialog to search the infobase. 

Query Template: Opens a customized Query dialog for the infobase (if a template is provided with the 

infobase). 

 

CLEAR QUERY 

 

NEXT  

Advances the cursor to the next line of query hits 

Click moves cursor to next number 

PREVIOUS 

Returns the cursor to the previous line of query hits. 

BACKTRACK: 

Backs you up through searches you have performed and links you have followed. 

 

TRAIL 

CONTENTS  

Opens up the Contents window for the infobase. The Table of Contents is a navigational tool designed to help  

you easily browse through the infobase. 

You may leave Help open and toggle between it and VIEWS (press ALT+TAB to toggle between open 

applications). You may also close Help when you are not using it by choosing Close from the File menu, or by 

pressing ALT+F4. 



 

HIGHLIGHTER 

BOOKMARK 

GO TO 

FIELD 

 

EXPLAIN VERTICAL SCROLL BAR 

In the vertical scroll bar on the right allows you to scroll the document window up or down by means of the 

mouse.  

EXPLAIN THE STATUS BAR 

The Status Bar shows your position in the GrandMan Infobase by record number, and also the query that is in 

effect, if any. The status bar also functions as a “Quick Help” line: as the cursor moves over items in the main 

menu, the status bar displays a brief message telling you what that item does. (Note: Folio’s online help often 

refers to the status bar as the “status line.” The terms “status line” and “status bar” will be used 

interchangeably.) 

SIMPLE AND EASY PROCEDURES 

FINDING  TEXT IN THE BIBLE 

Go to the Query Window. You can do this in 3 ways: Either push F2, or click on Search and then on Query, or 

click on the Query block on the Tool Belt.  

In the Query Window  you will see the Word window and the Query For window. Below this window you will 

see in blocks the two brackets [  ], the words Apply to all, Help, OK, and Cancel. 

Click on the bracket [ . The Word window will change to the Scope window with the words  Field, Group, 

Highlighter, Level, Note, amd Popup. Double clirck on the word Group and it will appear behind the bracket in 

the window below. 

Click once in the Query For window and the cursor will appear there one space behind the word Group. Now 

type in the passage you want (like Mark 1:1). Click on OK.  You will see the passage.  

FINDING  TEXT IN WRITINGS 

Go to the Query Window in either of 3 ways. Click on the bracket [ . The Word window will change to the 

Scope window with the words  Field, Group, Highlighter, Level, Note, amd Popup. Double clirck on the word 

Group and it will appear behind the bracket in the window below. 

Click once in the Query For window and the cursor will appear there one space behind the word Group. Now 

type in the passage you want (like AC 10). Click on OK.  You will see the passage. 

FIND A WORD OR COMBINATION OF WORDS 

Go to the Query Window in either of 3 ways. Type in the Query For window the word you are seeking (like 

secret). Above you will see you have 351 hits. Then click on OK. The word is colored so you can see it. You 

will see the firsty case, and when you click on NEXT, you will see the next hit. 

Type “lead us not into temptation” in the Quert For window. You will see 7 hits. Then click OK. You will see 

the first hit in blue. Click on NEXT and you will see the next hit. 

IF YOUR FINDS ARE  FAR APART 



 

FINDING THE INTERNAL SENSE OF THE BIBLE 

While you are reading in the Bible, you may ask yourself: What is the internal sense of this passage? It usually 

is very easy to find the internal sense of a bible verse. For example, go to Genenis 1:1, and click on that   in red. 

Automatically you are linked to all the passages in the Writings that speak about Genesis 1:1. There are over 

100,000 such links between the Bible and the Writings. But go to James 1:1 and that refrence is in light blue. 

Clicking on that reference will not lead to any other passage, there are no immediate link, there is no internal 

sense in the Writings, and you will have to search for the words via the Query Window. 

HOW TO COPY FROM GRANDMAN TO WORD PROCESSING 

Whatever you want to copy from the Document Window should be blocked first (Shift key and up/down or 

left/right keys. Then press CTRL C. Now go to Word, and in the Word window CTRL V, and the copied 

material will appear. Then save it.  

SHADOW FILES 

A shadow file is like a tracing paper you place over the top of a book page. You can write on the tracing paper 

and make various changes and additions in the text without changing the original text in the GrandMan 

Program.  

 

Each shadow file can be saved under a file name either somewhere on the hard disk or on a floppy, and can be 

returned to the GrandMan Program any time thereafter, but only one shadow file at a time. 

 

With a shadow file, you can change the text, font, format, and you can add bookmarks, notes and highlighters. 

The highlighters can have different colors. Any changes you make in the shadow file remain in the shadow file 

after saving. This capability allows for interesting applications. 

 

You can do specific research on a particular topic in one shadow file and perform another research project in a 

different shadow file. You can then return to these various research projects at any future time. You can send 

the shadow file to a friend or fellow researcher who also has GrandMan who can then see what you have done, 

can add to it, and then return to you. 

 

You can create your own groups and links. For example, if you create a complicated search, you can group the 

results with a customized group and then reference the group in a link. 

 

(An example is the Index infobase, that has a list of Writings topics taken from various works, and then this 

Index has links back to the Writings. Each link points to a list of writings passages that discuss the particular 

topic. A shadow file for the Index is also included so that the Index can be extended with links to new groups in 

one or more shadow files that you create. A shadow file is always created based on the text of the Info base that 

appears at the time on the screen. This could either be the GrandMan Infobase or the Index Infobase) .  

 

One thing we can do with the shadow file is to color those parts of the sense of the letter that are bare with one 

color, and the covered parts with another color. The doctrinal background can be put in the notes that are 

installed in different parts. 

 

We can change the font of all the letters, make them larger and thicker, so they are more visible to people who 

have vision problems. 



 

Ministers can use the shadow file to make the Writings more readable , to help people read the Writings, and to 

give various seminars. 

 

CREATING A SHADOW FILE 

 

1. Open the GrandMan Program. Then select "File" and"New". 

Make sure to specify your hard drive (Typically C:).  

2. Select the directory you want to put the Shadow File in. 

3. Change the File Type from "NFO" to "SDW". Then specify a new file name in the "File Name" field. Click 

on "OK".   

 

NOTE THAT THE SHADOW FILE WILL BE LOST IF YOU DON'T SAVE IT BEFORE YOU EXIT THE 

GRANDMAN PROGRAM. 

 

MARKING PASSAGES WITH "GROUPS" 

 

1. In the shadow file block  a section 

2. Click on Edit 

3.  Tag (F6)   Red lines appear in the left column 

4.  Customize 

5.  Group 

6.  Make new group name: "Covered" 

Make sure everything is tagged.  A Dot in the window in the little circle means that all tagged passages are 

included in covered group 

7.  Add 

8.  Apply (The window now disappears). 

9.  Edit 

10. Clear All tags 

11. Click - move cursor unselects text 

12. Save  

 

To add records to group: 

1.  Block different section 

Repeat steps 2 - 5  

6a.  In Window type "cov" 

6b.  In window below is a list, click "covered". 

6c.  On right side "tag" is clicked 

Repeat steps 8 - 12 above 

 

Query: 

If text is tagged do:  a. Block text  b. Edit  c. Clear all tags  d.  OK 

1.  Query 

2.  Type:  [Group Covered] 

3.  OK 

4.  View 



5.   "Records with Hits" must be clicked 

6.  Block text in query 

7.  Edit 

8.  Tag record 

 

If you click "Clear Query", "Covered" section in shadow file remains tagged. 

  

CHANGING THE TEXT 

 

ADDING BOOKMARKS 

 

ADDING NOTES 

 

ADDING HIGHLIGHTS 

 

BOOKMARKS 

COLORING OF SHADOW FILES 

NOTES IN SHADOW FILES 

REMOVING NOTES 

MARK PASSAGES WITH “GROUPS” 

MORE COMPLICATED PROCEDURES 

HOW TO GET SEARCH RESULTS IN FEW LINES 

SETTING PREFERENCES 

GraudMan Search can be customized in many different ways to suit your own preferences. Later on, you will 

learn about this in more detail. To start with we strongly recommend that you set your preferences as shown in  

Figure 3. This will ensure that your copy of GrandMan Search behaves the way the examples in the manual 

describe, and will help to avoid confusion. 

To do this, choose Preferences from the File menu. The dialog in Figure 3 will appear. Make changes so that the 

dialog on your screen exactly matches the picture; if you have just installed GrandMan Search, it should only be 

necessary to click Ribbon and Personalize and Records With Hits. When you are done, click OK. After setting 

the preferences, you will note that the program window has changed in appearance somewhat when compared 

with its original appearance shown in Figure 2. The Layout menu heading no longer appears on the menu bar, 

and there is no longer a horizontal “ribbon”of drop-down boxes and buttons immediately below the menu bar. 

Figure 3. Preferences Dialog 

NAVIGATING THE INFOBASE 

 In GrandMan there are often several ways to perform a certain task. Almost always there is a menu selection. 

In many cases there will also be a toolbelt button, a keyboard shortcut, or both. You are free to choose any of 

the suggested methods, as they all perform the same task. 

Because the GrandManInfobase is so large, our goal in this section is learning how to get around in the 

infobase. We will learn how to go directly to any book, chapter, verse, or number of the threefold revelation. 



We will also learn how to jump to and from cross-references in the text., and how to backtrack to previously 

visited passages. 

This section of the manual is structured as a tutorial. This means that you are expected to follow along while 

seated at your computer, entering the examples as they are presented. This is very much a “learn- by-doing” 

approach, and we encourage you to “do” as muchas possible. Don’t confine yourself to the 9ne ot two examples 

gwen here to illustrate each feature of the program. Try to come up with examples of your own, and use each 

feature until you are really comfortable with it. No one is looking over your shoulder or rushing you on to the 

next lesson, so take as much time as you like. Experiment with different possibilities. Don’t be afraid to try 

something which hasn’t been covered in the manual yet . 

Let me repeat: don’t be afraid to experiment and explore. There is nothing you can do which will damage your 

computer, the infobase, or the program, so don’t worry about that. The worst that can happen is that you may 

get yourself to a point where you don’t know how to get back to where you started. If this happens, stay calm. It 

isn’t the end of the world. Explore for a while. You will probably get back to familiar territory eventually. If 

not, all you have to do is exit the program (choose Exit from the File menu, or simply press ALT÷F4) and then 

start the program again. Then follow the instructions on page 6 to make sure that the program preferences are 

still set the way you want them. 

On the status bar, after the word Query, you may see [ Revelation/writings of emanuel swedenborg:]. Don’t 

worry now about what this means. It is put there automatically by GrandMan Search every time the program 

starts, and all you need to know at this point is that we want to get rid of it before we proceed with the tutorial. 

Click the Clear Query tool (alternately’, choose Search, Clear Query) and the query will be removed, as 

reflected by the status bar. 

CURSOR MOVEMENT AND SCROLLING 

Look carefully at the document window. You will see a blinking vertical line. This is the cursor, which always 

shows your position in the text. It behaves the same way as the cursor in a word processing program. Press the 

various arrow keys on your keyboard (up, DOWN, LEFF, and RIGHT) and observe how the cursor moves in 

response. At some point you may have observed a pause of several seconds before the cursor responded. 

Sometimes GrandMan Search for Windows will appear to pause in the middle of doing something. This is 

normal behavior. It happens when the program needs to retrieve more text from the CD-ROM. Because the CD-

ROM is a relatively slow device, and because the GrandMan Infobase contains such a large amount of text, this 

process can take a noticeable amount of time. Just be patient, and avoid the temptation to pound frantically on 

the keyboard. 

We have already noticed similarities to a word processing program, and you might wonder what happens if you 

type in some text. Tiy it! Nothing happens. The GrandMan hifobase has been designated as “read-only,” which 

means that you cannot add to it or delete from it. 

Press CTRL+END. The cursor jumps to the very end of the infobase (the last footnote at the end of The 

Spiritual Diary.) Note the status bar; it tells us that we are in record number 58805 out of a total of 58805. (In 

other words, the last record.) 

Press criu The cursor jumps to the beginning of the infobase, and the status bar announces that we are in record 

number 1 (out of a total of 58805). The cursor is in a gray box with large type, which reads Old Testament. This 

is the title of the first revelation. Note that Old Testament appears in the Reference Window as well. 

Press DOWN. You are now in record 2 (check the status bar), which is a white box with blue border and blue, 

slightly smaller type, reading Genesis. In the Reference Window, Genesis appears under Old Testament. 



Press DOWN again. You are in the chapter title. Press DOWN several more times. (See Figure 5.) As you move 

through the chapter, the three lines of the Reference Window continually tell you where you are in the infobase. 

When you get to Chapter 2, the Reference Window changes to reflect that fact. (Try it!) 

Figure 5. Cursor Movement and Scrolling 

Let’s move a little faster. Press PAGEDOWN several times, and see what happens. The PAGEUP and 

PAGEDOWN keys scroll the text a screen at a time. Note that when a key is pressed and held down, the action 

of the key repeats automatically for as long as the key is held down. 

You can also use the scroll bar to move around in the text. Try clicking on the arrows at the top and bottom of 

the scroll bar. To get repeat action, try clicking and holding down the mouse button. That little square thing on 

the scroll bar is sometimes called a thumb (see Figure 5). Clicking in the space below the thumb is similar to 

pressing PAGEDOWN. Now try dragging the thumb. Now we are really moving! The problem is, there is no 

way to tell where we are going to end up. Notice, by the way, that the scroll bar scrolls text relative to the 

Document Window, but leaves the cursor in its original position. As a result the Reference Window will not 

change, since it always reflects the position of the cursor. After scrolling by means of the scroll bar, you can 

move the cursor into the visible portion of text by clicking in the Document Window, or by pressing any cursor-

movement key, such as DowN. (Alternately, press n, or choose Window, Refresh.) 

 

WHEN YOU GET VISION PROBLEMS 

REFERENCES, CROSS REFERENCES, FOOTNOTES, AND BACKTRACKING  

PRINTING AND EXPORTING TEXT 

GRANDMAN PROGRAM DETAILS 

HOW LEVELS WORK 

MANIPULATING STYLES 

EXAMPLES OF DIFFERENT STYLES 

HOW CHARACTER STYLES WORK 

HOW PARAGRAPH STYLES WORK 

HOW LINK STYLES WORK 

NAMING CONVENTIONS FOR LINKS AND GROUPS 

CUSTOMIZING THE INFOBASE APPEARANCE 

QUERY SYNTAX SUMMARY 

USING THE CONTENTS WINDOW 

SHORTCUT KEYS 

FOCUS CERTAIN SECTIONS OF TEXT 

 

APPENDIX 1 

Abbr Book Records Abbr Book Records 



GEN GENESIS 2 - 1585 NAH NAHUM 23620 - 23670 

EX EXODUS 1586 - 2839 HAB HABAKKUK 23671 - 23730 

LEV LEVITICUS 2840 - 3726 ZEPH ZEPHANIAH 23731 - 23787 

NUM NUMBERS 3727 - 5051 HAG HAGGAT 23788 - 23828 

DEUT DEUTERONOMY  5052 - 6045 ZECH ZECHARJAH 23829 - 24054 

JOSH JOSHUA 6046 - 6728 MAL MALACHI 24055 - 24114 

JUD JUDGES 6729 - 7368 MATT MATTHEW 24116 - 25215 

* RUTH 7369 - 7458 MARK MARK 25216 - 25910 

1SAM 1 SAMUEL 7459 - 8300 LUKE LUKE 25911 - 27086 

2 SAM 2 SAMUEL 8301 - 9020 JOHN JOHN 27087 - 27987 

1 KINGS 1 KINGS 9021 - 9859 ACTS ACTS 27988 - 29023 

2 KINGS  2 KINGS 9860 - 10604 ROM ROMANS 29024 - 29473 

1 CHRON  1 CHRONICLES 10605 - 11576 1 COR CORINTHIANS 29474 - 29927 

2 CHRON  2 CHRONICLES 11577 - 12435 2 COR CORINTHIANS 29928 - 30198 

EZRA EZRA 12436 - 12726 GAL GALATLANS 30199 - 30354 

* NEHEMIAH 12727 - 13146 EPH EPHESIANS 30355 - 30516 

* ESTHER 13147 - 13324 PHILI PHILIPPIANS 30517 - 30625 

JOB JOB 13325 - 14437 COLO COLOSSIANS 30626 - 30725 

PS PSALMS 14438 - 17049 1 THES 1 THESSALONIANS 30726 - 30820 

PROV PROVERBS 17050 - 17996 * 2 THESSALONIANS 30821 - 30871 

* ECCLESIASTES 17997 - 18231 1 TIM 1 TIMOTHY 30872 - 30991 

SOL SOLOMON 18232 - 18357 2 TIM 2 TIMOTHY 30992 - 31079 

ISA ISAIAH 18358 - 19716 * TITUS 31080 - 31129 

JER JEREMIAH 19717 - 21133 * PHILEMON 31130 - 31156 

LAM LAMENTATIONS  21134 - 21293 HEB HEBREWS 31157 - 31473 

EZEK EZEKIEL 21294 - 22615 JAM JAMES 31474 - 31587 

DAN DANIEL 22616 - 22985 1PETER  1PETER 31588 - 31698 

HOS HOSEA 22986 - 23197 2 PETER  2 PETER 31699 - 31763 

JOEL JOEL 23198 - 23274 1 JOHN 1 JOHN 31764 - 31874 

AMOS AMOS 23275 - 23430 * 2 JOHN 31875 - 31889 

OB OBADIAH 23431 - 23453 * 3 JOHN 31890 - 31905 



JONAH JONAH 23454 - 23506 JUDE JUDE 31906 - 31932 

MICAH MICAH 23507 - 23619 REV REVELATION 31933 - 3239 

 Bible Book Names and Abbreviations 

 

APPENDIX 2 

Table shows all books of the Writings which are included in the GrandMan Infobase. 

Abbr. Book Records 

AC ARCANA COELESTIA 32361 -   43600 

HH HEAVEN AND HELL 43601 - 44505 

HD THE NEW JERUSALEM AND ITS HEAVENLY DOCTRINE 44506 - 44832 

L THE DOCTRINE OF THE NEW JERUSALEM CONCERNING THE LORD 44833 - 44916 

S THE DOCTRINE OF THE NEW JERUSALEM CONCERNING THE HOLY 

SCRIPTURE 

44917 - 45048 

LIFE THE DOCTRINE OF LIFE FOR THE NEW JERUSALEM 45049 - 45168 

F THE DOCTRINE OF THE NEW JERUSALEM CONCERNING FAITH 45169 - 45245 

DLW ANGELIC WISDOM CONCERNING DIVINE LOVE 45246 - 45687 

DP ANGELIC WISDOM CONCERNING THE DIVINE PROVIDENCE 45688 - 46050 

AR THE APOCALYPSE REVEALED 46051 - 47117 

CL CONJUGIAL LOVE 47118 - 47751 

TCR THE TRUE CHRISTIAN RELIGION 47752 - 48624 

Q NINE QUESTIONS 48625 - 48637 

AE THE APOCALYPSE EXPLAINED 48638 - 50397 

WHAPP  APPENDIX TO THE WHITE HORSE 50398 - 50402 

BE BRIEF EXPOSITION 50403 - 50524 

CHAR CONCERNING CHARITY 50525 - 50752 

CLJ CONTINUATION LAST JUDGMENT 50753 - 50847 

CORO  THE CORONIS (APPENDIX TO TCR) 50848 - 50908 

EU EARTHS IN THE UNIVERSE 50909 - 51145 

INV INVITATION TO THE NEW CHURCH 51146 - 51205 

ISB INTERCOURSE BETWEEN SOUL AND BODY 51206 - 51226 

LJ LAST JUDGMENT 51227 - 51320 

LJP LAST JUDGMENT POSTHUMOUS 51321 - 51693 



VERBO  THE WORD OF THE LORD FROM EXPERIENCE 51694 - 51764 

WH WHITE HORSE 51765 - 51782 

SD 

SDM 

THE SPIRTUAL DIARY 51783 – 58805   

 

 

HOW THE MANUAL CAME INTO BEING 

The GrandMan Windows manual was started by Cameron Pitcairn, later on sections were created and/or written 

by Walter J. Weiss, Mark H. Weiss or Jan H. Weiss, and certain sections were checked by various users of the 

program. This happened over a period of over ten years. 

 

MORE COMPREHENSIVE MANUAL 

Beyond this manual, there is more information under  the word Help in the menu bar. This information is from 

the Folio Corporastion, but does apply to the GrandMan Program. 

 

INVITING REACTIONS BY USERS 

As this Manual is on internet, it can be consulted by anybody and at any time. But each user is invited to make 

suggestions haw to improve the Manual. Email these suggestions to nco@secondadvent.net  


